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Introduction

General

KeyBoard Caper is a educational type software designed especially for children.    The 
game teaches children the layout of the keyboard and familiarizes them with alphabetical 
letters and numbers.    Using the interchangeable Character Packs, the game can also 
familiarize children with the different appearances that these characters can take on (due to
different typesets and fonts).

The game will present the play with a letter (or number) on the main game board and will 
then pause until the player presses the correct key.    When the correct key has been 
pressed, the letter (or number) will be added to the animated thumbnail area (at the top of 
the screen) and the letter will begin it's keyboard caper.    Occasionally, some of the letters 
on the main board will also 'come to life' and begin a keyboard caper of their own.......

If the player is having trouble locating the key, have them click anywhere on the main 
screen to bring up a Game Hint screen which will display a graphic of their keyboard and 
flash the location of the key in question.

Help is only a keystroke (or mouse click) away.    Fully context sensitive help is available by 
clicking on the control in question and then hitting the F1 key.    Also you can access the 
KeyBoard Caper Help from the Help menu item.    Additionally, wherever you see the 
KeyBoard Caper Logo, you may click on it to get a more general description of that 
particular screen.

Flexibility

The game is very flexible, allowing the player (or parent) to customize most every setting.    
The timer gauge can be disabled and removed from the screen if you feel it causes too 
much 'clutter'.    Also, the timer limit can be set. 

Additionally, you have the ability to customize some of the animation characteristics.    This 
can be done to affect machine performance, to enhance the animations sequences, or 
simply to 'goof around' and see how the animation sequences work.    The animation for the
thumbnail images (located at the top of the screen) can be disabled if you desire.    Also, 
the speed of the animation sequence can be adjusted.    You also have the ability to disable
and/or adjust the speed of the main character animations.    Also, the number of times the 
main character animation sequence is conducted can be set.

For players with slower machines (386 and lower), these settings can be tweaked to allow 
the game to continue at an acceptable pace.    If animations are struggling to complete on 
your machine then you can either lower the speed of the animation or disable the animation
entirely (note, disabling main character animation produces the most dramatic results).

Setting the number of times the main character animation is conducted can be useful for 
smaller children.    Since only selected few of the main characters perform animation 
sequences, sometimes the children (especially smaller children) may miss the animated 
sequence or catch it just about the time it completes.    If you notice this to be the case with 
your child, you can use this setting to cause the animated sequence to initiate more than a 
single time.



Finally, Game Hints characteristics can be customized.    The Game Hints function can be 
disabled if you desire.    This might be desirable if the child continues to mistakenly click on 
the screen and bring up the Game Hints screen.    Or, you could disable Game Hints and 
set the hints to come up with a press of the spacebar.    Whichever seems to be the easiest 
for your child - your choice.

Educational Value

KeyBoard Caper can teach the child the layout of a computer keyboard in a fun-filled 
manner.    In this day and age, familiarity with a computer keyboard is a necessity and a 
child is never to young to learn.

Additionally, the exposure to the alphabetical letters (both upper and lower case) and 
numbers will naturally assist the child in learning the alphabet and how to count.    All letters
and numbers are presented in their correct sequence so the child learns the correct order.   
Most children (if they do not already know) will want to know the name of the character (or 
number) and usually call them out loud while playing the game.    This is a good opportunity
to participate with you child and use KeyBoard Caper to teach many concepts related to 
the names of the characters, phonetics (how they 'sound'), numerical principles, etc.

Getting Help

We've done our best to make KeyBoard Caper as easy to use as possible by providing an 
easy-to-access online help engine.    KeyBoard Caper online help may be accessed in 
several different ways.    You may start the online help from the Help-Index menu option 
from the main game board.    This will bring up the Help 'table of contents'.    This is a good 
starting point.

Specific game instructions can be obtained from the Help-Game Play Instructions menu 
option from the main game board.

Most controls, gauges, data entry fields, etc. have context sensitive help attached to them 
also.    Click the control and press F1 to get specific help about that control.    If you cannot 
access context sensitive Help for a control, try checking the status bar for a brief 
explanation of the control's function.

Also, screens that contain the KeyBoard Caper logo contain general help discussions 
about that particular screen.    Click on the KeyBoard Caper logo to access online help 
pertaining to that screen.

Conclusion

There are no limits to what the child can learn using KeyBoard Caper.    The game by itself 
serves to teach the child the layout of the computer keyboard as well as familiarity with the 
different letters and numbers.    While this is certainly well worth the price of registration, we
would also hope that the parent could use this game as an opportunity to teach the child 
other alphabetical and numerical principles.    By sitting down with the child and 
participating while they play the game, KeyBoard Caper can becoming a very valuable tool 
in you teaching repertoire.    Everything in life can be used as a 'learning' experience - but 
KeyBoard Caper was designed to facilitate a learning experience in manner that will surely 
provide the child with much delight.

Enjoy!





Game Play Instructions

Beginning a new game

Before beginning a game, ensure that all of the Game Layout and Game Environment 
settings are set to your liking.    Then click on File-New Game to clear the game board and 
set it up for a new game or alternatively, click on the Play Game button located above the 
Stop button on the button bar.

Game play operation

Once the game has been started, the first character will be displayed on the main board.    
The player should locate and press this key on the keyboard.    When the correct key has 
been pressed, the character will be added to the thumbnail character area (located at the 
top of the screen) and will begin it's KeyBoard Caper.    Then next character will be 
displayed on the main board and play continues.

Characters on the thumbnail character area are animated one-at-a-time in sequence.    The
speed of the animation can be adjusted from the Game Environment screen.

Every so often, one of the characters on the main board will also become animated and 
conduct a keyboard caper after its key has been located and pressed.    The speed and 
number of times it cycles through its animation sequence can also be adjusted from the 
Game Environment screen.

Game conclusion

Once all of the characters have been found and pressed, the play will be presented with a 
screen congratulating them and the current game will end.    To setup a new game simply 
click on File-New Game to clear the board and set it up for a new game or alternatively, 
click on the Play Game button.



Menu Options

The KeyBoard Caper Menu Bar contains the following items.    Click on the Menu Bar item 
below for more information.

File -    File menu options

Options -    Set game options

Help -    Help, registration, distribution instructions



File Menu

The File Menu contains the following options    Click on the file menu option below for more 
information.

Open Picture File -    Opens a new Character Pack

New Game -    Starts a new game.

Exit KeyBoard Caper -    Exit KeyBoard Caper



Open Picture File (File Menu)

Introduction

The authors of KeyBoard Caper chose to implement the display of game characters a little 
differently than you may be used to.    Rather than develop the game so that all game 
characters were included within the game itself, KeyBoard Caper uses a specially 
formatted input file called a Character Pack.    This allows you to change Character Packs 
and present the player with a little more variety (Character Packs differ in the type of font 
the characters are presented in and in color schemes).    Additional Character Packs are 
constantly being developed and are available for a modest charge to registered users 
(contact SparTech Software for a list of currently available Character Packs, including 
'seasonal' Character Packs).

The default Character Pack file is loaded automatically into KeyBoard Caper when the 
game begins.    The last Character Pack file used will be the default Character Pack file.    
To switch to another Character Pack, you use this menu option.

Opening a Character Pack

Ensure that all Character Packs are kept in the same directory as KeyBoard Caper to 
assure that they show up correctly in the Open Picture File screen.    To switch to another 
Character Pack, simply scroll to the Character Pack you wish to load and click.    This 
Character Pack will be loaded into the game board and used in all subsequent sessions 
(until you change to another Character Pack).



New Game (File Menu)

The New Game menu option will clear the current game board and set up a new game.    
Pictures will be randomly selected and arranged on the game board.

This option may be chosen at any time (including while in the middle of playing a game).

Note that it may be necessary to press the Play Button in order to actually start the game.  
This is usually necessary if a game has just been completed or some part of the game 
layout has just been changed.    If you select New Game menu option while in the middle of
playing a game, the game pieces are set up and the game started automatically.



Exit KeyBoard Caper (File Menu)

The Exit KeyBoard Caper option will close the KeyBoard Caper program and return 
control back to Windows.

All game settings will be saved and restored the next time KeyBoard Caper is restarted.



Options Menu

The Options Menu contains the following options.    Click on the option below for more 
information.

Game Layout -    Set Game Layout options

Game Environment -    Set Environment options



Game Layout (Options Menu)

From this screen you may change the graphic type used in the KeyBoard Caper game.    
Graphics types include Upper Case Letters, Lower Case Letters, and Numbers.    To 
choose a different graphic type simply click on the graphic type selection and then click the 
OK button to accept the changes you have made.



Game Environment (Options Menu)

Changing the KeyBoard Caper environment

From this screen you may alter settings that affect the general KeyBoard Caper game 
environment.    Settings related to the game board and animations (both Thumbnail Images 
and Main Character Images) may be altered.

Changing Game Board Settings

From here you may show/hide the game timer by checking the Display Timer Gauge 
option.    You can also set the Game Timer Limit Setting.    This time limit is actually not 
very restrictive.    If the game time specified expires, the player is still allowed to continue 
(the time remaining gauge will change from 'time remaining' to 'time over').    

If you do not wish to use the Game Timer to actually time a game but do wish to keep it on 
the board for added animation effect, realize that the lower the time limit specified, the 
quicker the Timer Remaining gauge will change.

From here you can also configure how Game Hints can be activated.    Game Hints can be 
set to activate when any surface of the game playing area is clicked (by checking Enable 
Game Hints On Click) or when the space bar is pressed (by checking Enable Game 
Hints On Spacebar).

You may choose to disable KeyBoard Caper sound effects.    You can do this by removing 
the check mark for the Enable Sound setting.

Changing Thumbnail Images Settings

Thumbnail animation can be configured here.    You can enable Thumbnail animation by 
checking the Enable Animation option.    Additionally, you can set the animation speed by 
adjusting the slider labeled Animation Speed.

Changing Main Character Images Settings

Main character animation can be configured here.    You can enable Thumbnail animation 
by checking the Enable Animation option.    Additionally, you can set the animation speed 
by adjusting the slider labeled Animation Speed.    

By adjusting the Repeat Animation slider, you can alter how many animation cycles the 
main character goes through.

Restoring Default Values
 
Click on the Defaults Button to restore all values back to their original defaults.



Display Timer Gauge

Setting the Display Timer Gauge option (from the Options-Game Environment screen) will
allow the display of the Game Timer Gauge on the game board.    Unchecking this option 
will suppress the display of the gauge and disable the game timer.



Game Timer Limit Setting

The Game Timer Limit Setting option (from the Options-Game Environment screen) 
allows you to specify a game time limit for the current game.    This game timer will be 
updated immediately without affecting any game you may currently be playing.



Game Time Limits

A game time limit may be set to provide a more competitive game playing environment.    
This time limit is not very restrictive.    When the time expires you simply receive a message
informing you of such and are allowed to continue (if the Game Timer Gauge is displayed, 
the gauge will change from a 'time remaining' gauge to a 'time over' gauge.



Enable Game Hints On Click

Checking this option (from the Options-Game Environment screen) will allow the play to 
click anywhere on the main board to bring up the Game Hints screen.

If the player is inadvertently bringing up the Game Hints screen (by accidentally clicking on 
the main board) then you may wish to disable this option.



Enable Sound

Checking this option (from the Options-Game Environment screen) will cause KeyBoard 
Caper to produce sound effects when a correct key is pressed, and incorrect key is 
pressed, and when a game is completed.    You may wish to disable this option (by 
unchecking) if your computer does not have a sound card.



Game Hints

Game hints are provided to assist the player in locating the correct key.    Accessing game 
hints can be done by either clicking anywhere on the main board or by pressing the 
spacebar (depending upon your Game Environment settings).

The game hints screen will display a graphic of your keyboard (or a keyboard similar to 
your keyboard.    The current character on the main game board will be shown as 'flashing'. 
The player should then be able to get a general idea of where the key in question is 
located.

To close the Game Hints screen, you may click the OK button or simply click on any part of 
the Game Hints screen.



Enable Game Hints On Spacebar

Checking this option (from the Options-Game Environment screen) will allow the player to 
press the spacebar to bring up the Game Hints screen.

If the player is inadvertently pressing the spacebar (common with smaller children) then 
you may wish to disable this option and possibly set the Enable Game Hints On Click 
option instead.



Enable Animation (Thumbnail)

Checking this option (from the Options-Game Environment screen) will enable the 
Thumbnail animation sequences (located above the game board).

If this animation proves distracting or your machine cannot process the graphics quickly 
enough then you may wish to disable this option (first try decreasing the Animation 
Speed).    Note that the Thumbnail Animation sequences are the least 'processor intensive' 
graphics in KeyBoard Caper - therefore if processor speed has become a problem you may
wish to tweak the Main Character animation graphics first.



Enable Animation (Main Character)

Checking this option (from the Options-Game Environment screen) will enable the Main 
Character animation sequences (for certain characters).

If this animation proves distracting or your machine cannot process the graphics quickly 
enough then you may wish to disable this option (first try decreasing the Animation Speed
or Repeat Animation).    Note that the Main Character animation is the most 'processor 
intensive' graphics in KeyBoard Caper.    If processor performance has become a problem 
then you may wish to tweak these graphics first.



Animation Speed

KeyBoard Caper was designed so that the animation speed of the animation sequences 
could be adjusted by the user.    This was done for two reasons - (1) so the user could set 
up the animation appearance more precisely to their liking, and (2) so users with slower 
machines could slow down the animation in order to obtain more desirable performance.

The animation speed can be changed from pre-programmed values ranging from 1 to 50.    
The incremental change in animation speed is not the same for each pre-programmed 
value.    The lower the value (i.e. the slower the animation speed) the greater the 
incremental difference.    For example, the difference between animation speeds 49 and 50 
(the two fastest speeds) may only be a couple of milliseconds while the difference in 
animation speeds 1 and 2 may be a few hundred milliseconds.

KeyBoard Caper has been tested on a variety of platforms.    Most 486 and Pentium 
machines should have no trouble with even the fastest animation speeds.    386 users may 
need to drop the animation speeds down a little.    If animation still appears to be 'jerky' then
you may need to disable the animation entirely (try disabling the main character animation 
first since it is the most processor intensive graphic).



Repeat Animation

The Main Character animation can be set to cycle through the animation sequences from 
1 to 6 times.    The default setting is once.    However, testing indicated that some smaller 
children were so involved in finding the correct key that after finding and pressing the key 
they paused to reflect on their accomplishment before looking back up at the screen.    If 
the character chosen was one of the Main Character animations then they usually missed 
some of the animation.    Rather than pre-program a pause before the animation sequence 
(we did not want to slow down the game play for more advanced players), we allow the 
player to set how many times they wish the animated sequence to repeat.    Usually 2-3 
repetitions is enough for most children to be able to notice and enjoy the animated 
sequence.



Thumbnail Animation

Thumbnail animations occur after the player has found and pressed the correct key.    A 
thumbnail image will be placed above the game board for every correct key chosen.    
These thumbnails will produce sequential animations, cycling through each of the 
thumbnail characters.    When the game has been completed, all thumbnail animations are 
accelerated.



Main Character Animation

Selected Main Characters will produce animation sequences.    The characters that become
animated vary with each Character Pack.    The speed of the animation can be adjusted 
via the Animation Speed setting.    Additionally, the number of times the Main Character 
animation cycles through can also be set by the player (via the Repeat Animation setting).

Main Character animation sequences are the most processor intensive graphics in the 
KeyBoard Caper game.    They can sometimes cause performance problems on lower end 
386 machines.    Tweaking the Animation Speed and Repeat Animation values can 
eliminate these performance problems.



Defaults Button            

Clicking on this button will restore all of the values in the Game Environment screen back 
to their original default values (as pre-programmed by SparTech Software.



Yes Button

Yep, I want to do exactly what this screen says.



No Button

Nope, I changed my mind.



Help Menu

The Help Menu contains the following options.    Click on the option below for more 
information.

Index -    Display the Help Index

Game Play Instruction -    Display brief KeyBoard Caper instructions

KeyBoard Caper Registration -    Access KeyBoard Caper registration functions

Create Distribution Copy -    Create a KeyBoard Caper distribution copy

About -    Display the KeyBoard Caper About screen



Index (Help Menu)

Clicking the Index menu option brings up the KeyBoard Caper Help Index (Main Menu).



Game Play Instruction (Help Menu)

Clicking the Game Play Instruction menu option brings up the KeyBoard Caper Help 
Instruction screen containing brief instructions on playing the KeyBoard Caper game.



KeyBoard Caper Registration (Help Menu)

KeyBoard Caper 1.1 is distributed under the shareware concept.    This method of 
distribution allows you to try out our software before you purchase it.    If you do not 
continue to use the software you simply agree to remove it from your system.    Otherwise, 
you are expected to register the software with the vendor (see registering KeyBoard 
Caper for further details and benefits of program registration).

Clicking on the KeyBoard Caper Registration menu option will bring up the registration 
screen.    This screen allows you to actually register the software by clicking on the 
Register Button or print the registration form by clicking the Print Registration Form 
Button.



Program Registration

KeyBoard Caper is NOT free.

KeyBoard Caper 1.1 is distributed under the shareware concept.    This method of 
distribution allows you to try out our software before you purchase it.    If you do not 
continue to use the software after a reasonable length of time (generally regarded as 30-
days), you simply agree to remove it from your system.    Otherwise, you are expected to 
register the software with the vendor.

To register the software you must first send in your registration fee.    Once the fee has 
been processed, you will promptly be supplied with a user name, serial number, and pass 
code that you then enter on the Help-KeyBoard Caper Registration-Register screen.    Once
the correct codes have been entered, the program will be flagged as registered.

Some of the advantages of registering KeyBoard Caper (other than a clear conscience) 
include:
(1)    no more 'Nag' screen!
(2)    half-price upgrades on future versions of KeyBoard Caper.
(3)    20% off on other SparTech Software software packages.
(4)    notification of new Character Packs.
(5)    notification of new releases of KeyBoard Caper.
(6)    notification of new SparTech Software software package releases.

To register KeyBoard Caper:

(1)    Choose KeyBoard Caper Registration from the Help menu.
(2)    Click on the Print Registration Form button.
(3)    Complete the registration form.
(4)    Make your check payable to Brian F. Haddock.
(5)    Mail the registration form and your payment to

SparTech Software
1309 Windy Meadows Dr.
Burleson, TX 76028

You will receive your registration user name, serial number, and pass code that you then 
enter to update KeyBoard Caper's status to 'registered'.

Note: if you are not able to print the registration form, please contact SparTech Software 
for the most recent price list and further instructions on registration.

Thanks for your interest in registering KeyBoard Caper!



Register Button            

Clicking the Register Button brings up the registration screen where you may register 
the KeyBoard Caper software..



Registration Screen

After mailing in your registration form and payment, you should have received a packet 
containing a User Name, Serial Number, and Pass Key.    If you did not receive these 
then contact SparTech Software for further instructions.

Upon receipt of the registration packet, enter the items in the text boxes provided.    Click 
OK to accept the items you entered.    If everything was entered OK then you will receive a 
message informing you that KeyBoard Caper has been registered and requesting that you 
restart KeyBoard Caper for the new 'registered' status to take effect.

If everything is not entered correctly then you will receive a message informing you that 
KeyBoard Caper was not registered.    If this occurs, please reenter the items specified 
again to assure that you did not enter one of the them incorrectly.    Check to assure that all 
spaces, numbers, letters, etc. are entered exactly as they appear on your registration 
packet.    Also look for common mistakes such as entering a 0 (number 0) rather than an O 
(letter O) or an I (letter I) rather than a 1 (number 1).

If KeyBoard Caper still will not register then contact SparTech Software for further 
instructions.



User Name

Enter the User Name as specified in your registration packet.    Please ensure that the User
Name is entered exactly as it appears on the registration form provided.



Serial Number

Enter the Serial Number as specified in your registration packet.    Please ensure that the 
Serial Number is entered exactly as it appears on the registration form provided.    

Note that the Serial Number may contain a combination of letters and numerals.



Pass Key

Enter the Pass Key as specified in your registration packet.    Please ensure that the Pass 
Key is entered exactly as it appears on the registration form provided.

Note that the Pass Key may contain a combination of letters and numerals.



Print Registration Form Button            

Clicking the Print Registration Form button brings up the print registration form screen 
allowing you to print the KeyBoard Caper registration form (which is mailed in along with 
your registration fee in order to register the KeyBoard Caper software).



Create Distribution Copy (Help Menu)

Clicking on the Create Distribution Copy menu option will bring up the create distribution 
copy screen.    This screen allows you to    create a distribution copy of the KeyBoard Caper
software so that you may participate in the SparTech Software Distribution Incentive 
Program and possibly earn a free registered copy of KeyBoard Caper.



About (Help Menu)

Clicking this option brings up the KeyBoard Caper About screen.



Screen Layout

Click on the topic below for more information concerning screen components of the 
KeyBoard Caper game.    Alternatively, you may select the object on the screen and click 
the PF1 key to access the context sensitive help.

Game Board Gauges

KeyBoard Caper Menus

KeyBoard Caper Toolbar



Gauges

Click on the topic below for more information concerning gauges used in the KeyBoard 
Caper game.    Alternatively, you may select the gauge on the screen and click the PF1 key 
to access the context sensitive help.

Game Timer Gauge -    Game time remaining

Status Bar -    short descriptive messages



Game Timer Gauge

This gauge displays the time remaining in the current game.    

When the gauge reaches its maximum value it will automatically be reset to zero and begin
counting again.    You will receive a message indicating that the time for this game has 
expired.    The gauge numeric display will change from black to red and the caption will be 
changed from 'time remaining' to 'time over'.

The numeric display located below the Game Timer Gauge is a textual representation of 
the game time remaining (or time over) in a minutes:seconds format.



Status Bar

The KeyBoard Caper status bar (located along the bottom of the screen) will display 
several useful bits of information.    In the large box on the left, you will find the status 
message area.    This area displays short descriptive messages will be displayed informing 
you of such things as the results of you last action or the current screen control that the 
cursor is resting on.

To the left of the status message area is the key presses count.    This area displays the 
number of keypresses the player has made during the current game.

Located on the right of the status bar is the average time area.    This area displays the 
average time between each correct keypress (up to the current game piece).



KeyBoard Caper Toolbar

The KeyBoard Caper toolbar allows children to easily change the type of game pieces 
displayed and to pause a game in progress or start a new game.    

Choices for game piece types include capital letters, small letters, or numbers.    

Note that when game piece types are selected from the menu the corresponding button on 
the KeyBoard Caper toolbar will be automatically depressed.

Click on the toolbar button below for more information about that button.

    

    

            

        



Capital Letters Button            

The Capital Letters Button (located on the KeyBoard Caper Toolbar) is used to specify 
upper case letters type game pieces.



Upper Case Letters Game Pieces

All letters displayed will be upper case (capital) letters.    Each letter is presented in its 
proper sequence.

Different Character Packs contain slight variations in the styles and colors of letters.    This 
is useful in presenting the various appearances that a alphabetical character can take.



Lower Case Letters Button            

The Lower Case Letters Button (located on the KeyBoard Caper Toolbar) is used to 
specify lower case letter game pieces.



Lower Case Letters Game Pieces

All letters displayed will be lower case (small) letters.    Each letter is presented in its proper
sequence.

Different Character Packs contain slight variations in the styles and colors of letters.    This 
is useful in presenting the various appearances that a alphabetical character can take.



Numbers Button            

The Numbers Button (located on the KeyBoard Caper Toolbar) is used to specify 
numbers game pieces.



Numbers Game Pieces

All numbers displayed will be in their proper sequence.    Only number 0 - 9 are presented.

Different Character Packs contain slight variations in the styles and colors of numbers 
(including numbers displayed as Roman Numerals).    This is useful in presenting the 
various appearances that a number character can take.



Play Button            

The Play Button (located on the KeyBoard Caper Toolbar) serves two different functions.    
It can be used to restart a paused game or to start a new game.

If the game has been paused (via the stop button) then the Play Button will appear as an 
hourglass and will represent the restart function.

If different choices have been made concerning game piece types or the number of game 
pieces or if a game has been completed, the Play Button will become the New Game 
button (button graphic is a 'green' stoplight).    Pressing the Play Button is required to restart
the game and will automatically set up a new game board with the new options selected.



Pause Button            

If the game has been paused (via the Stop Button) then the Play Button will appear as the 
Pause Button (with an hourglass graphic) and will represent the restart function.    To restart
the game, simply click on the Pause Button.



Stop Button            

The Stop Button (located on the KeyBoard Caper Toolbar) can be used to pause a game 
in progress.    The game timer will also be paused.



Distribution Program

SparTech Software offers its users a unique software distribution program the was 
developed to provide users with an incentive to further the distribution of KeyBoard Caper 
shareware software.

The concept is very simple.    If you are an unregistered user you may earn enough credits 
to obtain a free product registration.    If you are a registered user you may earn enough 
credits to get all of the money you paid back!

What do you have to do?    Simple.    Let us explain.

First, you must put an original installation copy of KeyBoard Caper in a separate directory 
(create one via MD if needed).    This original copy is the first unregistered copy of 
KeyBoard Caper that you downloaded and used to install KeyBoard Caper on your 
machine - it should contain the SETUP program and it's associated compressed installation
files.    If this copy if zipped then unzip it before continuing and delete the *.ZIP file.    Please
be sure that a separate directory is used for this process to assure that only the required 
KeyBoard Caper files are included in the new distribution copy you create.

Next you need to fill out the Distribution Incentive Program form (obtained from Help-
Create Distribution Copy menu option).    This will create a KEYBOARD CAPER.DST file 
in your installation directory containing the necessary information about yourself (so that we
may get you proper credits to you).    The KEYBOARD CAPER.DST file should have been 
created in the installation directory and not your KeyBoard Caper directory.

Upon completing the Distribution Incentive Program form, you will be prompted with a 
screen requesting you select the directory that the installation files are located in.    After 
selecting the directory and clicking 'OK', KeyBoard Caper will perform a verification of 
installation files.    If all required files are not found or additional files are found (that should 
not be included with the installation files) then you will receive a message informing you of 
the missing (or additional) files detected.    Most often this is a result of specifying the 
incorrect installation directory.    If you receive this message, assure that you specified the 
directory where the installation files have been unzipped.    If you still receive the message 
then this is indicative of a corrupted copy of KeyBoard Caper.    You should contact the BBS
where you obtained KeyBoard Caper and inform them that the KeyBoard Caper copy you 
download from them is incomplete or corrupted.    A 'good' copy of KeyBoard Caper 
(containing all the required files) should be obtainable from another online service provider.

Finally, zip the KeyBoard Caper installation files and your new KEYBOARD CAPER.DST 
file and upload the software to you favorite BBS or online service.    Whenever a user 
registers a copy of KeyBoard Caper, the registration form (printed) contains the info you 
entered above so that you will be properly credited with the registration.

Simple huh?

If you are a registered user of KeyBoard Caper, you will receive an entire refund if 3 or 
more people register off of this distribution copy.    If you are an unregistered user, it takes 6
people or more to earn you a free registered copy of KeyBoard Caper.

These numbers actually are very reasonable.    The larger the BBS or online service you 
upload the copy to, the better your chance of other users registering off of your copy.

The hardest part is finding a BBS to upload to.    Most sysops won't allow you to upload an 



already existing copy of software so you must find a BBS that doesn't already have a copy 
on file.

When you reach your required credits, we will promptly provide you with the appropriate 
serial number and pass code and inform you of the registration steps to take or, if you are a
registered user, we will promptly refund your money.

In summary, to create a KeyBoard Caper Distribution Copy:

(1)    Put your original (unregistered) installation copy of KeyBoard Caper in a separate 
directory.
(2)    Unzip the original installation copy (if zipped).
(3)    Delete the zip file.
(4)    Complete the Distribution Incentive Program form (KEYBOARD CAPER.DST file 
created in the installation directory) and specify the installation directory.
(5)    Zip the files back up to create uploadable copy for distribution.

If you have any questions concerning the Distribution Incentive Program, feel free to 
contact SparTech Software.

Thanks for your interest!



Distribution Incentive Program Form

This form should be completed in order to participate in the Distribution Incentive 
Program.    The data you complete in this form is written to a file named KEYCAPER.DST 
that you include with your uploadable KeyBoard Caper software.

The Distribution Incentive Program Form consists of two parts.    Only 1 of the two parts 
needs to be completed.    If you wish to quickly receive your registration serial number and 
pass code then complete the Email section.    If you do not have a Email address then 
complete the US Mail section.

Also, if you are a registered user be sure to enter your registration serial number.

Click on the topic below for further details on data entry in the Distribution Incentive 
Program Form.

Email

Name -    User Name
Email Address -    Internet Email Address

US Mail

Name -    User Name
Address -    US Mail Postal Address
City -    City part of mailing address
State -    State part of mailing address
Zip -    Zip code of mailing address

Registration Serial Number -    Registration Serial Number



Name

Enter your full real name.    The data input can be any alphanumeric text but must be less 
than 30 characters long.



Email Address

Enter your Internet Email Address.    This address cannot be a Online Service Email 
Address unless it is accessible via the Internet (most are).

This address will be in a form such as YourEMailName@something.com,



Address

Enter your mailing address.    This is the US Postal Service mailing address such as the 
street address or Post Office box number.

Two lines are provided if your mailing address will not fit on a single line.



City

Enter the city part of your mailing address.



State

Enter the state abbreviation part of your mailing address.    Note that this must be the 
state's name abbreviation and not the full name.



Zip Code

Enter the Zip Code part of your mailing address.    Data input should be in the form such as 
99999 or 99999-9999.



Registration Serial Number

If you are a registered user then please enter your Registration Serial Number that was 
provided to you with your registration packet.

For registered users, this must be completed for proper credit.



Credits

Kudos to the following, whom without, KeyBoard Caper would never have 
materialized.

Blake -    my little 6 month old buddy, who always makes programming more of a challenge
(ever tried to hold a kid in one hand and type code with the other? - try it!, It's harder than 
juggling.......).

Cameron -    for your grueling, relentless testing sessions, hour after hour, day after day, 
constantly pounding the keyboard looking for 'bugs' - that only a three-year old could have 
discovered.    A definite member of my 'permanent' beta facility.

My Wife - for her wonderful enlightenments, tips, and ideas (and sometimes quite blunt 
too) that only a computer novice could have dreamed up.    They all served to make 
KeyBoard Caper a much better program.    Sorry I could not bring all of your ideas to life 
(never did figure out how to make that letter jump off the screen and walk around the desk -
ah well, there's always tomorrow).

And finally, to every user who supported the shareware concept by registering (in good 
faith) their copy of KeyBoard Caper (I don't do this for fun you know.......    on the other 
hand, maybe I do!).



Contacting SparTech Software

SparTech Software welcomes your questions, comments, and suggestions.

SparTech Software may be contacted via Email at spartech@flash.net, on the Web at 
http://www.flash.net/~spartech, or via U.S. Mail at SparTech Software, 1309 Windy 
Meadows Dr., Burleson, TX 76028.

In your correspondence, please include the name and version number of the software 
package your question or comment refers to.    Also include your name and address (Email 
address preferred).    If you're a registered user, include your software serial number and 
registration code (for verification).

Any 'bug' reports should also be directed to the addresses above (yep, we're not perfect    - 
remind us sometime to tell you the story of 'Dorian', the programmer who made a pact with 
the devil that in return for his programs being preserved as perfect, any problems that 
would have degraded his programs would afflict his own person instead - scary stuff!).

Once again, we welcome any comments.



OK Button

Clicking on the OK button will close the current screen.    If the current screen required data
entry, the data will be saved before closing the screen.



Cancel Button

Clicking the Cancel button will close the current screen.    If the current screen required 
some type of data entry (such as entering data in a text box, choosing an option from a 
drop down list box, etc.), the data will not be saved before closing the screen.



Help Button

Clicking this button will bring up KeyBoard Caper Help regarding the specific function you 
are currently attempting.



A Character Pack is a collection of specially formatted graphics files that contain the pictures 
used on the KeyBoard Caper game pieces.    These Character Packs are user selectable and 
interchangeable (can be switched out with another Character Pack) in order to offer more variety 
in the game playing environment.

Note that only a single Character Pack can be selected at a time.



The Game Board is the term used to indicate the game playing surface area in KeyBoard Caper. 
This includes the area where the game pieces may be located.



Context sensitive help is a special feature of the Windows Help system that allows you to select
a control you need more information about (i.e. give the control the focus) and press the F1 key 
in order to bring up the online help specific to that particular control.    If a particular control does 
not have context sensitive help attached to it, you will receive a message informing you of such.

You give the control in question the focus by clicking on the control.    

If the control is a command button and you do not wish to actually execute the command buttons 
operation, then you click the command button and drag the cursor off the button before releasing 
the mouse button.    This will give the command button the focus without actually executing the 
command buttons operation.

If the control is a menu option and you do not wish to actually execute the menu option's 
operation, then you click the menu option and press F1 before releasing the mouse button.    This 
will bring up the context sensitive help regarding that menu option (after the online help screen is 
displayed you may release the mouse button).



ZIP file is a term used to indicate a file compressed using PKWare's PKZIP utility.    This utility is 
also shareware and can be easily downloaded from any BBS or online service.



You asked for it, you got it!    This is the 'official' KeyBoard Caper logo (accept no substitutes!).

On screens that contain the KeyBoard Caper logo, you may click on the logo to obtain a overview of that 
screen's particular function (in this case clicking on it will simply make it disappear).






